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s CTIP
% Continuous Test & Integration Platform
= Code Editor
= Eclipse CDT
B Unit Test
= CUnit
% Source Code Management
= Subclipse
% Integration Building
= make command & makefile Integration 7/ W\
% CI Tool e 4

Test
= Hudson

SCM(Source
Code

Management)




Code Editor

e

< Ecliplse IDE for C/C++ Developers

B http://www.eclipse.org/downloads/

Eclipse Downloads

Packages DeveloperBuilds Projects

Compare Packages Older Versions

Eclipse IDE for Java Developers, 99 M8
Downloaded 1,574,524 Times Details

= Eclipse IDE for Java EE Developers, 206 MB
ood Downloaded 1,161,113 Times  Details

‘ Eclipse Classic 3.6.2 171 mB
Downloaded 822,124 Times Details Other Downloads

Google Plugin for Eclipse  Fremated Downicad

Development tools to design, build, optimize and deploy cloud applications.

Eclipse Helios (3.6.2) Packages for [l e cONES

Windows 32 Bit
Windows G4 Bit

Windows 32 Bit
Windows 64 Bit

Windows 32 Bit
Windows 64 Bit

g Download

Eclipse IDE for C/IC++ Developers, a7 MB
Downloaded 382,915 Times Details

Windows 32 Bit
Windows 64 Bit

% Eclipse for PHP Developers, 141 1B
Downloaded 218,240 Times Details

Eclipse IDE for JavaScript Web Developers, 107 B
Downloaded 79,210 Times Details

‘ Eclipse Modeling Tools (includes Incubating components), 247 Mg

Downloaded 56,253 Times Details

Windows 32 Bit
Windows &4 Bit

Windows 32 Bit
Windows 64 Bit

Windows 32 Bit
Windows &4 Bit

But Eclipse not

support Compiler!!



http://www.eclipse.org/downloads/

Code Editor

< C Comilper for Windows
= Mingw(Minimalist GNU for Windows)

B http://sourceforge.net/projects/mingw/
L1 setup - MinGw-Get =] @ ==

Select Components

hoose which optional companents of MinEW to install {the C compiler is abways e
installed) 4

[] M3YS Basic System

MSYS(Minimal System)
* Provide shell environment
* Install for installing CUnit

[ < Back “ Mext = ][ Cancel ]

® Adding Mingw's bin folder to Path enviroment variables
= CWMInGWHtbin
= CWMInGWWmsys#1.0Wbin


http://sourceforge.net/projects/mingw/

Code Editor

e

< Create Project, file
= File>New>C Project, Source File
[ = C Project E@M ra Mew Source File

C Project — Source File

[ESREEX
Ny
Create C project of selected type r Create a new source file. L

- —

Project name:  CTIPAC Source folder: CTIP4C Browse..

Use default location I Source file:  main.d |
Location: |D:w1.vc-rkspace+ilC'l'[Pf-C | | Browse... | Template: [D-efault C source template '] [ Configure... ]
Project type: Toolchains:

= Executable || MinGW GCC |

@& Empty Project

@ Hello World ANSI C Project
(== Shared Library
(= Static Library
(= Makefile project

@ [ Fnish ][ Cancel

Show project types and toolchains only if they are supported on the platform

@ | <Bsck [ mest> ][ Finsh [ cancel |




Code Editor

e

» Build / Run

[ main.c &2

#include <stdio.h>

int main()
{

b [ Inc Go Into

b (= De b lgm  Open
b [g ma Open in New Window Open With g
Copy Ctrl+C
Copy Paste Ctrl+v
Pacte ¥ Delete Delete
Delete = Remowe from Context Ctrl+Alt+Shift+Down
Move...
% Remove from Context SR— —
Move... o
Rename... ey Export..
&  Refresh F5
Ry Import. o
Make Targets ’
i3 Export.. aKe e
Run As » | [&] 1 Local C/C++ Application
Build Project
) Dilds ' Run Configurations...
Profile As »




o CUnit

Unit Test

% Unit Testing Framework for C
% Platform dependent (Curses on Unix)

B http://cunit.sourceforge.net/

CUnit

A Unit Testing Framework for C

Overview
Documentation
Screenshots
Contacts
Exaronle Cada
Donwload Link
Project Home

SOURCEFORGE.NET*

~ HTML
~ 4,01

ClUnitis a lightweight system for writing, administering, and running unit tests
in C. It provides C programmers a basic testing functionality with a flexible
variety of user interfaces.

ClUnit is built as a static library which is linked with the user's testing code. It
uses a simple frameworl for building test structures, and provides a rich set of
assertions for testing common data types.  |naddition, several different
interfaces are provided for running tests and reporting results. These interfaces
currently include:

Automated Output to xmil file _Non- :
interactive

Basic Flexibleprogramming _Non- _
interface interactive

Console Console interface (ansi C)  Interactive

Curses Graphical interface (Lnix)  Interactive


http://cunit.sourceforge.net/
http://cunit.sourceforge.net/

Unit Test

¢ Install CUnit(1/3)

% Download “"CUnit-2.1-2-src.tar.bz2"

= http://sourceforge.net/projects/cunit/
B Decompression File

= tar -xvjf CUnit-2.1-2-src.tar.bz?

B CMANIndow sty stern 32%emd. exe

» —wujf CUnit-2_1-2-syrc.tar_bz2
A-2.

.1-2/NEWS
A-2/Makefile.am
.1-2/conf igure
A-2/cunit.po.in
.1-2/TODO

.1-2/INSTALL

.1-2/Man~

1-2/Man/man3/
1-2/Man/man3-Makefile .am
1-2/Man/man3~-Makefile.in
A1-2/Man/man3~ClUnit.3
.1-2/Man/Makef ile.am

1-2/Man/Makefile.in
1-2/depconp
.1-2rsaclocal.md

[ 5 /Sl



http://sourceforge.net/projects/cunit/

Unit Test

¢ Install CUnit(2/3)
% shell mode
= sh (MSYS command)

% set Install configure
= /configure --prefix=<Install path>

BN C#windowsieysterna2wcmd. exe - sh =] =] =]

D:WCUnit-2.1-2>sh
sh—-3.15% _/configure —prefix=d: Clnit
checking for a BSD-—compatible install... rusesbinrinstall —c

checking whether build environment iz sane... yes

A /CUnit—-2.1-2/missing: Unknown “—run’ option

Try “d ClUnit—2.1-2/ g ——help’ for more information
conf igure: WARMING: ng’ script is too old or missing
checking for a thread—safe mkdir -p... Ausr/bin/mkdir —p

% Generate Install makefile by configure
= make
BN C:¥hWindowsWsystem324#%cmd exe - sh ===

sh-3.15 make

make all-recursive

make[11: Entering directory "“rdsCUnit-2.1-2’

Making all in ClUnit

make[21: Entering directory "“rd-CUnit-2.1-2-/CUnit”*

Making all in Sources

make[31: Entering directory "rd-CUnit-2.1-2-/CUnit-Sources’
Making all in Framework




Unit Test

¢ Install CUnit(3/3)

%M Install CUnit

= make install

Making install in
make [1]1: Entering
Making install in
make [2]1: Entering
Making install in
make [3]1: Entering
make [4]1: Entering

Making install in
make [3]1: Entering
make [4]1: Entering

BN C:¥wWindowsseysten32wemd.exe - sh =N =h

zh-3.1% make install

make [4]1: Mothing to be done for “install-exec—am’.

make [4]1: Mothing to be done for “install-data—am’.
make [4]: Leaving directory "Ad/CUnit-2.1-2-/CUnit-Sources Framework’
make[3]1: Leaving directory "Ad/CUnit-2.1-2-/CUnit-Sources Framework’

make [4]1: Mothing to be done for “install-exec—am’.
make [4]1: Mothing to be done for “install-data—am’.
make[4]: Leaving directory "Ad/CUnit—2.1-2/CUnit-Sources/Automated’

Clnit

directory "s/d/CUnit—2.1-2/CUnit’

Sources

directory "/d/CUnit—2.1-2/CUnit/Sources’

Framework

directory "d/CUnit—2.1-2/CUnit/SourcesFramework’
directory "d/CUnit—2.1-2/CUnit/SourcesFramework’

Automated
directory "sd/CUnit—2.1-2/CUnit/Sources/Automated’
directory "sd/CUnit—2.1-2/CUnit/Sources/Automated’

4 . ClUnit
doc
include
liky
share

* doc : CUnit document(Html)

e include : Header files

e lib : Libraries

» share : XML DTD, XSL, man files



Unit Test

e

“ Setting for Eclipse
% Setting Compiler’s Include path
= Project>Properties>C/C++Build>Settings
= GCC C Compiler>Includes
= add CUnit's include folder

~ Properties for Cunit [ o [ 2] =]
|typefi|ter text | Seﬂings = R
Resource
Builders
C/C++ Build Configuration: ’Debug [ Active ] '] [Manage Configurations...

Build variables

Discovery Options
Enwironrnent B Tool Settings |,3‘" Build Stepsl Euild Artifactl Binary Parsersl @ Error Parsers|
Logqing

| Seftings B3 GCC Assernbler Include paths (- 28 85 &
Tool Chain Editor 2 General
C/C++ General By GCC C Compiler

Project References 2 Preprocessor
Refactoring History 22 curphnl
Run/Debug Settings | E“’:'?‘ Includes I
Subwersion (# Optirnization
Task Repository 2 Debugging
Wiki Text 2 Warnings
2 Miscellaneous
B3 MinaW C Linker
2 General
2 Libraries
2 Miscellaneous
(2 Shared Library Settings




Unit Test

e

“ Setting for Eclipse
% Setting Linker’s Libraries
= Project>Properties>C/C++Build>Settings
= MinGW C Linker>Libraries
= add Libraries “cunit”
= add CUnit's lib folder

&2 Tool Seftings |.3" Build Stepsl 97 Build ,t\rtifactl Binary Parsers | @ Error Parsers

4 33 GCC Assemnbler Libraries (-l £ &8 8 58
= General
4 B3 GCC C Compiler
(# Preprocessor
2 Symbols
(2 Includes
# Optirnization
# Debugging
2 Warnings
2 Miscellaneous
4 B3 MinGW C Linker
2 General
| (% Libraries| |
(=2 Miscellaneous
(2 Shared Library Settings

Library search path (-L) L ER ER=REY




Unit Test

e

@ Test CUnit(1/3)
% Using CUnit's Example Code

.
= Build
ul
[ project Beplorer 52 = O |[|g makefile =g
=
9:5‘ H #include "Clnit/Basic.h" i ®
5 CTIPAC [CTIP2C] :?“Ci“:e ::EEH?‘;;EDDSNE . 2”h"
1§ Cunit [Cunit] include nit/Automated.
4 Binaries -
@]Includes. int init suite success(void] { return 0; } o=
8 C/MinGWyinclude int init_suite failure(void] { return -1: }
@CﬁM!nGWﬂ\b{gcdmmgwa, int clean suite success(void] { return 0; } @
CMinGuizlib/gce/mingws: int clean suite failureivoid] { return -1:; }
D/CUnit/include - -
= DEEUQ void test successl(void)

% Cunit exe - [xA6/le]
rain.o - [x86/1g]
[# maines 11 6 2 2% 259 &

{
CU_ASSERT (CU_TRUE) ;
i

void test_successZuiﬂj I
i

CU_ASSERT NOT EQUAL(Z, -1):

void test_success3 (roid)
{

O ASSERT STRTMG ROMAT. i"=tyineg #17. "arring #1701

[

El console 22 [ Prob\ems} | Tasks] =] Proper‘tieﬂ

T B Bkt E-riv=0

C-Build [Cunit]

*¥** Rebuild of configuration Debug for project Cunit *%%%

ok

FEEE Hﬁiinﬁl Builcﬁr i Lﬁd for bujild

gee -ID:AVCUnithyinclude -00 —-g3 -Wall -c -fmessage-length=0 -—omain.o
goe -LD:LVCUnith lib -oCunit.exe main.o -lcunit

Smain. e

FENITO CONpleCe LOr DroJect

Time consumed: 531

I

ms.

D#

Writable Srnart Insert 16:25




Unit Test

» Test CUnNIt(2/3)

%= Run Executable file
» Using Basic.h * Using Console.h

ClUnit - & unit testing framework for © - Version 2.1-2 ClUnit - A Unit testing framework for C - Version 2.1-2
http://ounit.sourceforge. net/ http://cunit.sourceforge.net/

Guite: Suite_success FEEEFEEEFEERFAEEF CUNIT CONSOLE — MAIN MENT ## #6558 6558 b F A AR AR RFARRFAFHFR
Test: successful test_1 ...passed (Blun (Sielect (Liist (Ajctivate (Flailures (Olptions (Hielp (Q)uit
Test: successful test_2 ...passed Enter command:

Test: successful test_3 . ..passed

WARNING - Suite initialization failed for 'Zuite_init_failure'.

Suite: SuitE_Clean_failure EEEXXXXEEENXXXE5Y CUNIT CONSOLE — MATN MENU ## & 883 daadddd a0 T L2888 5%%%
Test: successtul test g ...passed (Rjun (Sjelect (L)ist (A)ctivate (F)ailures (O)ptions (Hjelp (Qjuit
Test: failed test 2 ...FAILED

= — Enter command: F
1. ..\main.e:38 - CU_LSSERT _EQUAL(Z,3)
Test: succ#ssful_test_l T..passed . S I OO Test Bun Failures .

WMAFRMNING - Zuite cleanup failed for 'ZSuite clean failure'. X X X X -

i X K — — src file:lineff : (suite:test) : failure condition
Suite: Suite mixed - -
zesz: :uc_jezsfulgtjﬂ—zF)'lﬁ';:ssw 1. CUnit System:D : (Suite_init failure : ] : Suite Initialization failed -
E? : \al = Eja— i ASSERT STRING EQUAL("atring #17. "string 427 2. ..\main.c:38 : (Suite clean failure : failed test 2] : CU_ASSERT EQUAL (2
T ; 'é m?lz':' . 2_ FLILED _EQ {"string slETring ! 3. CUnit Syster:0 : (Suite clean failure : | @ Suite cleanup failed.
E? : \al = Eja— v ASSERT EQUAL (2,3 4. ..\main.c:48 : (Suite mixed : failed test_4) : CU_ASSERT STRING EQUAL|"s
v oemRLn. el — — (2.3 5. ..\mwain.c:38 : (Suite mixed : failed test 2] : CU ASSERT EQUAL(Z,3)
Test: successful test_4 ...passed R - - - __-
. . Total Nuwber of Failures : 5
Fun Suranary: Type Total Fan Passed Failed Inactiwve
suites 4 3 nfa =4 u]
LEests 13 10 7 3 u]
asserts 10 10 7 3 nfa

Elapsed time = 0.001 seconds
1. CUnit System:0 - Zuite Initialization failed - Zuite Skipped
2. ..vwain.c:38 - CU_ASSERT EQUAL(Z,3)

3. CUnit System:0 - Suite cleanup failed.
4. ..\main.c:48 - CU_ASSERT STRING EQUAL ("string #1","string #2")
5. ..vwain.c:38 - CU_ASSERT EQUAL(Z,3)




Unit Test

<?xml wersion="1.0" >

* Test CUnNIt(3/3)
. Oxml-styleshest type="text/xsl" href="Clnit—Run.xsl® 75 Aut ted Test R; R It
B Run Executable file [ s ol e HOTIRTEE T R

<CUNIT EEADER/>
<CUNIT_RESULT_LISTING>
<CUNIT RUN_SUITE> Eunning test successful_test 1 . Passed

.
° U A t I I I t d h <CUNIT_RUN_SUITE_SUCCESS:> :
SI n u O a e . <SUTTE_NANE> Suite_success </SUITE_HANE> Running test successful_test 2 Passed

<CUNIT_RUN_TEST_RECORD> Running test successful_test 3 . Passed

Running Suite Suite_success

<CUNIT_RUN_TEST SUCCESS>

<TEST_MNAME> successful test 1 </TEST NAME> R . Swte Swte ]_n_lt fa_]lure
4 '[;_-5 Cunit [Cunit] </CUNIT_RUN_TEST SUCCESS> lnning it | -

</ CUNIT_RUN_TEST JRECORD> Rutmine Suile Sui 1 o
[ [ uite Duite_clean ure
K] i:,;b Binaries <CUNIT_RUN_TEST_RECORD> Wnming X |

CCUNTT RUN_TEST SUCCESS> Eunning test successful test 4 Passed
q I | d <TEST_NAME> successful_test_2 </TEST_NAME> ==
4 5 Includes e e onccrses Rumsingtestfied_seer 2
. . </CUNIT RUN TEST RECORD>
* @ C.fMlnGWfrlndUdE <CUNIT_RUN_TEST RECORD> File . .
L . . . . <CUNIT_RUN_TEST SUCCESS> Name Amain ¢ Line Number =3
K B CfMInGWfIIb;‘gcc,-‘mlngW <TEST_NANE> successful_vest_3 </TEST_NANE> .
@ CoMi G"..I".,I'ﬂbf c/mi . </COMIT RUN_TEST SUCCESS> Condition CU_ASSERT EQTALZ,3)
> i N | CCSING Y, /CUNIT_RUN_TEST_RECORD :
g g </ZUNIT_REN_SEITE_§UCCESSZ Eunning test successful_test 1 . Passed

K] @ D:fCUniUincIude </CUNIT_RUN_SUITE> . . . .
Eunting Suite Suite_clean_failure
a = Debug

» F Cunit.exe - [x86/le]
s rain.o - [x8&/le] Listing of Registered Suites & Tests

- [el mainc 5 11 6 2 ©7F 358 . —
o Initialize Cleanu Test .
g CunitAutornated-Listingxrml | © EXGCUtab|e f||e Fonetion? Fanetion? Coun Active?

CUnitAutorm ated -Results=ml M Suite Suite_success Tes Tes 3 Tes
e enerate XML file
Eﬂ CUnit-Listedtd 5 11 & 2 9;3 g Test successfil_test 1 Tes

Test successfiul_test 2 Tes

Jfﬁi CUnit-Listxsl 5 11 6.2 Q:ﬂ Test successfil test 3 Yes
L Cunit-Rundtd 5 11 6 2 27 Suite Suite_init Failure Yes Mo 3 Tes
JS& CUnit-Run.xsl 5 11, & 2 EEI Test successfil test_1 Yes
Test successfil test 2 Yes

. . Test successfil test 3 Yes

® Use CUnIt/SharelS DTD, XSL flles Suite Suite_clean_failure MNe Tes ] Tes
Test successfil test 4 Yes

Test faled test 2 Yes

Test successful test 1 Tes




SCM

e

< Source Code Management
% Subversion - Subclipse
%= Help>Install New Software
B http://subclipse.tigris.org/update 1.6.x

r- . .
SVN Repositories &3 . [ SVN Annota
'a Install R— @E‘g ﬁ
Available Software —
Check the items that you wish to install. { 4 D EVﬂ.fkaStEr.lptl me. Drg
4 [&= CTIPAC
Work with:  http://subclipse tigris.org/update_1.6.x - Add... .CprDjE"Ct 2
Find more software by working with the "Available Software Sites” preferences. _prgject 2
|type filter text ‘ @ main.c 2
Mame Version ['?ﬁ' makefile 2
1> [J] 000 Core SWNKit Library
i [¥]000 Optienal JNA Library (recommended)
> [¥]000 Subclipse
= i = Ty
. . , [ Project Explorer &2 B8
=
| selectAll | [ Deselectal g items selected q:b | @
Detals 25 CTIPAC [CTIPAC]
E ¥ Binaries
Show only the |atest versions of available software [ Hide items that are already installed @ Irl C| L IjE,E.
[¥] Group items by category What is already installed? E.B mainc 2 11.5 31 2= 0:33 oy
[¥] Contact all update sites during install to find required software |
P ? ! ) CTIPAC.exe - [x86/le]
main.o - [x86/1e]
[y makefile 2 11.5 31 2= 933 s
® ‘ < Back |I ext = ] | Finish | [ Cancel l



http://subclipse.tigris.org/update_1.6.x

Integration Building

< Use makefile for Integration building
= similar to build script

% Create Makefile Project, makefile
= New>C Project, File

-
- | g T - "
et (25 Project Explorer 52 = B
C Project — =
) . o RN
Project name must be specified [ =
— ES CTIPAC
il Includes
Project name: @ main.c
Use default location | & makefile
Location: | D-Wworkspace Browse...
Project type: Toolchains:
; P
(= Executable -- Other Toolchain -- | & makefile &3
@ Empty Project | MinGW GCC: |
@ Hello World ANSI C Project all : compile run
(= Shared Library compile : main.c
= Static |ibrany i
(= Makefile project geC —C maln.c
@ Empty Project goo —o CTIP4C.exe main.o
clean : CTIP4C.exe malin.o
Show project types and toolchains only if they are supported on the platform FIo main.o
rm CTIF4C.exe
run : CTIP4C.exe
CTIP4C.exe
@ = Back Mext = Finish




Integration Building

< Use mingw32-make.exe
% Proejct>Properties>C/C++ Build>Builder Settings
% Set Build command : mingw32-make.exe

= Properties for CTIPAC

o |o[E g

type filter text C{C++ Build R g
[» Resource
Buijlde
Configuration: [Default [ Active ] 'l [Manage Configurations...

p C/C++ General
Project References
Refactoring History = Builder Settings | @ Behaviour
Run/Debug Settings

1 Task Repository Builder

WikiText Builder type: External builder

[] Use default build command

IBuiId command:  mingw32-make.exe I

Makefile generation
[7] Generate Makefiles automatically Expand Env. Variable Refs in Makefiles

Build location
Build directory:  ${workspace_loc:/CTIPAC}

Worksp&oe...] ’File system...] ’Variablﬁ...]

’ Restore [_)efaultsl ’ Apply ]

Cancel ]

@ Lo ]I




Integration Building

» Edit makefile
% Build Defualt : Label “all”

omakefile
all : compile run
Label —> cnmpilel | main.c [€&— dependency

oo -0 Inalh. o
must use tab <

execute statement

gz —o CTIP4C.exXe main.o

clean : CTIP4C.exe main.o
rin mImsin.o
rin CTIP4C.exe

run : CTIP4C.e=xe

CTIF4C .exe #E Console &2 . [21 F‘mblemﬂ ¥ Tasks| & Pro
C-Build [CTIPAC]

#%%% Build of configuration Default

BU//OI mingwiz-make.exe all

goo —o main.o
goo —o CTIP4C.exe main.o
CTIP4C . exe

Hello World




Integration Building

% Selective Build
% Project>Make Target>Build

[Project] Window Help

Open Project b Jr=r iy @ (1 51 v 5] v
Close Project
o1p  Build All Ctrl+B
Build Configurations »
Build Project
Build Working Set »
Clean... " . . "
Buld Automatically Uncheck “Build Automatically
Make Target > Create... = Make Targets =
Properties Build:.. shi Make Targets for: CTIPAC
IR A . Target Location Add...
. o (@) all B
Target is makefile’s label | [@den
(&) compile
(@) run
Selective Build in Command-line
. [ Build ] [ Cancel I
: mingw32-make <label>




Cl Server

¢ Hudson

B http://hudson-ci.org/

% Download “hudson.war”
% java -jar hudson.war

o

BN CiWindowsisysternd2vwomd. exe - java -jar hudson war o &[S

D:Wrjava —jar hudszon.war

Running from: D:Whudson.war

[Winstone 20118681 13:58:34]1 - Beginning extraction from war file

hudzon home directory: D:WhudsonSrc

28011. 6. 1 EEEE 1:5%8:3% hudson.util.CharacterEncodingFilter init

%ﬁEE: CharacterEncodingFilter initiali=ed. DISABLE_FILTER: false FORCE_EMCODING:
falsze

[Winstone 2811-86-.81 13:58:35]1 — HTITP Listener started: port=8BHEA

Using one—time self-signed certificate

[Winstone 2011-86-.81 13:58:35]1 - AJP13 Listener started: port=H007

[Winstone 2011-86-81 13:58:35]1 - Winstone Servlet Engine vB.?_.18 running: contro

1Port=disahbled

2811. 6. 1 5535 1:5%8:3% org.hudsonci.inject.internal.SmoothieContainerBootstrap
hootstrap

?'E: Bootsztrapping Smoothie

2011. 6. 1 52?31:53:36 hudson.PluginManager createPluginStrategy

%152: Plugin strategy: org.hudszonci.inject.internal.plugin.DelegatingPluginStrat
egy

2011. 6. 1 Ei 1:58:36 hudson.model.Hudson$5 onfAttained

EﬁEE: Started initialization



http://hudson-ci.org/
http://hudson-ci.org/
http://hudson-ci.org/

Cl Server

*» Hudson

% http://<ip address>:8080
% Create New Job
= Select "Build a free-style software project”

Hll(lso‘_l ] &, search (7 hmanager | 202
Hudson = All
] =E¥ [ crIPac |
Hudson sc| @ Build a free-style soﬂ:ware project
MerE 0132 Hudsen2 &2 2SYLCH Hudson2 (H= WE AAE0 HE SCMEAE2)2E S0 M8 TZTHES WeE AL,
SHEH ":_-!EEEl E} HE M k== ME2E = gL

©) Build a maven2/3 project

My Views Maven2/3 DEMEES WCRI|C} Hudsons POM TIHYY OIS AT U1 SHs 2®S SULCHL

©) Monitor an external job

YE O == 0§82 B2 AHE SHHY Hudson 2HM SBEIs D24 282 IS5k 22 ASEUCHL IZH 2HUHM, NE
7 =20 2aLch 2 A= ."\Iﬁf:é!—l (AIESZ 4 HudsonS AFS® 2= ﬂeLIE} RAE 482 E:‘ (HE18 24 5.

I in ﬁlwﬁ‘-. i
g

) Build multi-configuration project

£ 2El Crzrat BEfMe 8, EAE 4 2E, DI £ HE O3 NZE0E 33230 2828 SZHEY SHgsE.
1 02 D A=Emu =
2 M = Copy from | |




Cl Server

< Job Configure

Project name |CTIP4C

Description

[T piscard old Builds

[ This build is parameterized

] pisable Build (Mo new builds will be executed until the project is re-enabled.)
[7] Execute concurrent builds if necessary (beta)

Advanced Project Options

Source Code Management

) None

@ cvs

®

@06

Build Triggers

[ Build after other projects are built
@ Trigger builds remotely (e.g., from scripts)

[T] pall sCM

L Build paciadically

Build

Ppoeoee

Execute Windows batch command @

Cemmand mingwiZ-make

See the list of available senvirenment variables

r—
@ sSubversion

Modules Repaository URL |wn 1/ kester.iptime.org/CTIP4C | (2)

Update credentials

Local module directory (optional) |

| @

Enroll Repository

Ignore externals option [

()
()

Add more locations...

Check-out Strategy | yge ‘svn update’ as much as possible

[~]

Use 'svn update’ whenever possible, making the build faster. But this causes
the artifacts from the previous build to remain when a new build starts.

Add build step

Add build step |

Execute Windows batch cormmand ®
Invoke Ant

@
Execute shell
Invoke top-level Maven targets @

Use Excute Windows batch command
: “mingw32-make.exe” build project
using makefile

|| Perform Subversion tagging on successful build

Repository browser | (Auto)

=L Save




Cl Server

e

+» Build

Hudson
Hudson = CTIPForC
* Back to Dashboard Project CTIPForC
Q Status
= chenges 2 Hudson

Hudson = CTIPForC = #£2

oDEHER S04 @ bl = #9 (2011. 6.1 2= 1:58:12)
]

h workspace

E Build Mow

- Build History {trend)

|° #9 2011. 6.1 2% 1:55:12 I

= -
#8 2011.5, 31 PZ 11:57,25 s ot ctoni
#7 2011.5,31 2= 11:18:79 * Last succes ~— % Revision: 3
e Last failed | = Mo changes.
#6 2011.5.531 P 11:17.:40 o Last unsuc e

#5 2011.5.31 TF 11:10:58

s D@l e »

@ NS LD 2/ AT

#4 2011.5.31 2F 9:52:17

#3 2011.5.31 2F 9:51:27

#2 2011.5.31 2% 9:50:40 —
O = = :é=E:|
= =

#1 2011.5.31 2%F 9:49:51

far all B far failures

ceeececCcOoCOEO

Started by user huser

Updat ing svn://kester, ipt ime, org/CTIPAC revizion: 2011, 6, 1 2% 1:58:12 depth:infinity ignoreExternals: false
A&t revision 3

rno change for svn:/fkester, iptine,org/CTIPAC since the previous build

[workspace] % cmd fc call C:#UserstkesterrtappDat sfloca ¥ Tenptihudzon 6223633931 78330809, bat

D:#¥hud=zonSrc j ob=¥CT I PFor C¥work space=mingw3Z-mak e
goc -C main, o

gcc -0 CTIP4C exe main,o

CTIPAC, exe

Hella Warld
O:fhudsonSrol jobsWCT IPForCwork space=exit 0
Finizhed: SUCCESS
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¢ Test Process

1. Write functions for testcases
= suite init/cleanup if necessary
2. Initialize the test registry
= CU_initialize_registry()
3. Add suites to the test registry
= CU add suite()
4. Add tests to the suites
» CU_add_test()
5. Run tests using an appropriate interface
» CU_basic_run_tests()
» CU_automated run_tests()
= CU_console _run_tests()
6. Cleanup the test registry
= CU_cleanup_registry
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»» Write functions for Testc

B Using CUnit Assertions
= Similar with JUnit
= Defined by CUnit.h

% Assertion Functions (1/2)

dSES

CU_ASSERT(int expression)
CU_TEST(int expression)

Assert that expression is TRUE (non-zero)

CU_ASSERT_TRUE(value)
CU_ASSERT_FALSE(value)

Assert that valve is TRUE (non-zero)
Assert that valve is FALSE (zero)

CU_ASSERT_EQUAL(actual, expected)
CU_ASSERT_NOT_EQUAL(actual, expected))

Assert that acfuval = = expected
Assert that acfual'= expected

CU_PASS(message)

Register a passing assertion with the specified message.

No logical test is performed.

CU_FAIL(message)

Register a failed assertion with the specified message.

No logical test is performed.
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** Assertion Functions (2/2)

CU_ASSERT_PTR_EQUAL(actual, expected)
CU_ASSERT_PTR_NOT_EQUAL
(actual, expected)

Assert that pointers acfual == expected
Assert that pointers acfval'= expected

CU_ASSERT_PTR_NULL(value)
CU_ASSERT_PTR_NOT_NULL(value)

Assert that pointer value == NULL
Assert that pointer va/ve != NULL

CU_ASSERT_STRING_EQUAL(actual, expected)
CU_ASSERT_STRING_NOT_EQUAL
(actual, expected)

Assert that strings acfval and expected are equivalent
Assert that strings acfval and expected differ

CU_ASSERT_NSTRING_EQUAL

(actual, expected, count)
CU_ASSERT_NSTRING_NOT_EQUAL

(actual, expected, count)

Assert that 1st count chars of
acfual and expecfed are the same
Assert that 1st count chars of acfual/ and expected differ

CU_ASSERT_DOUBLE_EQUAL

(actual, expected, granularity)
CU_ASSERT_DOUBLE_NOT_EQUAL

(actual, expected, granularity)

Assert that lacfual - expected | {= | granularity |
Assert that lacfual - expected| > | granularity |
Math library must be linked in for this assertion.
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% Create Project

-
= C Project

C Project —

Create C project of selected type [

Project name: SortTest

Use default location

Location: | D-#tworkspaceftSortTest Browse...

Project type: Toolchains:

(= Executable -- Other Toolchain --

= Shared Library | MinGW GCC: |

(&= Static Library

(= Makefile project
@ Empty Project

Show project types and toclchains only if they are supported on the platform

@ < Back Net> |[ Ensh ][ cancel

4 [== SorTest
4 [aj)l Includes
b olE C/MinGW/include
b (= C/MinGW/lib/gec/mingw32/4.5.2/include
BB C/MinGW/lib/gec/mingw32/4.5.2/include-fixed
b (= D:/CUnit/include
a = XML
G Cunit-List dtd
42 CUnit-List xsl
|z3| Cunit-Run.dtd
4 CUnit-Run.xsl
i [€ Selection_Sort.c
i [n Selection_Sorth
I+ | testSelection_Sort.c

omeetle w  Project Setting
- include directory
- library path
= copy from CUnit/share
= add Files to Test
= add Testing file
= add makefile for Build
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2 Write Testcase

= Testsuitel

void test exp (void) {
char array[MAX SIZE]="abedea":
selection sort(array):

void test_equal (void) {
char array[MRX S5TZE]="zbedea";
selection_sort (array);

= Testsuite?

vold test int (veoid) {
char array[MRX STZE]="582547";
selection_sort (array);

CU ASSERT (arrav[0] == 'a'}): CU_ASSERT EQUAL(arrav[0],'a'): CU_ASSERT STRING EQUAL (array, "245578");
CU ASSERT (array[l] 'a'): CU_ASSERT_EQUAL (array([l1],'a'): ¥

CU LSSERT (arrav[2] == 'b'}: CU_ARSSERT_EQUAL (array[2],'k'): vold test capital (void) {

CU ASSERT (array[3] — 'd'): CU_ASSERT_EQUAL (array([3],'d"): char array[MAX SIZE]="EMCDOH";

CU LSSERT (array[4] == 'e'};: CU_ARSSERT_EQUAL (array[4],'e'): selection_sort (array);
CU_ASSERTtarray[S] tety; CU_ASSERT EQUAL(arrav[5],'e'): CU_ASSERT STRING EQUAL (array, "CDEHMO");:

¥

void test trume (void) {
int isEqual;
char array[MAX S5IZE]="adebci";
selection sort(array):
if(stromp (array, "abocdef")==0)

}

void test string(veoid){
char array[MAX SIZE]="abedea";
gelection sort(array):
CU_ASSERT STRING EQUAL (array,

}

"abcdef™) ;

¥

vold test special (void) {
char array[MAX SIZE]="("@=#>";
selection_sort (array);
CU_ASSERT STRING EQUAL (array,

H

isEqual = TRUE: void test _fail (void){ vold test mix(void){
else char array[MAX S5IZE]="abedea"; char array[MAX SIZE]="la&Vie";
isEqual = FALSE: selection_sort (array); selection_sort (array):

CU_ASSERT_TRUE (isEgqual):

CUO _FATL("fail test fail"):

" (R=>E0) ;

CU_ASSERT STRING EQUAL (array, "#1&Vae"):
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< Write main Function for Testing

int main{)
{

CU_pSuite testSuite=NULL; Declaration Suite Variable

7% initizlize the CUDit test registry */
CU initialize registry():

Initialize Registry

/% add a suite to the registry */

testSuite = CU add suite("ASSERT Test®, NULL, NULL): add Suite to Reqistry

f# add the tests to the =suite */

CU_add test(test3uite, "ASSERT TEST", test_exp):

CU_add test(testSuite, "ASSERT TRUE TEST", test_true); add Testcases to SU'te
CU_add test(test3uite, "ASSERT EQUAL TEST", test_equal);

CU_add test(testSuite, "ASSERT STRING TEST", test_string):;

CU add test(testSuite, "ASSERT Fail Test", test fail):

testSuite = CU_add smite("Type_Test", NULL, HNULL):
CU_add test(test3uite, "TYPE INT TEST", test_true);:
CU_add test(testSuite, "TYPE CAPITAL TEST", test_equal);
CU add test(testSuite, "TYPE SPECILL TEST", test string):
CU_add test(test3uite, "TYPE MIX TESTt", test_fail):

JS% Run all tests using the automated interface */

CU automated run tests(): Run Test - XML Output

CJ li=st teztz to file():

f* Clean up registry and return */

CU_cleanup_registry(): Clean up Registry

retorp CU get error(l:
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*» Write makefile

all : compile link run move
compile : Selection Sort.c testSelection Sort.c

goo —ID:A\CUnith\include -o Selection Sort.o —-c¢ Selection Sort.c

goe —ID:A\CUnithinclude -o testSelection Sort.o -c test3election Sort.c
link : testSelection Sort.o Selection Sort.o

goe —-LD:\CUnit\1lib -o SortTest.exe test3election Sort.o Selection Sort.o -lcunit
run : S5ortTest.exe

SortTest.exe
move ! Clnithutomated-Listing.xml CUnitAutomated-Results.xml

mv CUnitAutomated-Listing.xml ./X¥ML/Listing.xml

mv CUnitiutomated-Eesults.xml ./ XML/Results.xml
clean : Selection S5Sort.o testSelection S5ort.o SortTest.exe

rm Selection Sort.o

rm testSelectinn_Snrt.n
rm Sortlest.exe

compile : gcc with -I option

link : gcc with -L option

run : generate Test Result(XML)
move : moving XML files

clean : delete object, executable files
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»» Build makefile

_ N\ ™
In Eclipse In Hudson

& console 2 = Problemq ¥ Tasks} =] Propertie.q = =
TaE a5

C-Build [SortTest]

**%% Build of configuration Default for project SortTes Started by user hmanager

Updat ing svn://kester  iptine,org/SortTest revizion: 2011, 6, 3 8 4:43:54 dep

. At revision 8

mingw3d-make all no change for svn://kester, iptime, org/SortTest since the previous build

gocc —ID:\CUnithinclude -o Selection_Sort.o -c Selection [workspace] $ cnd /o call C:#UserstikesternéppDat atiloca |#Temptihudson 7355361446

goc -ID:\CUnit\include -o testSelection Sort.o -c tests D Mhudsons rotl ] absiSor t Testuor k . _—
- . - HWhudsonSrol j ol ort Test#wor k space=ningw3Z-make , exe

gee -LD:\CUnit\lib -o SortTest.exe testSelectlon_Surt.a gec —ID:WEUni'gWinclude -0 Selectlijon_SorTE,’o -c Selection_Sort .o

SortTest.exe goo —ID:WCUnit#inzlude -0 testSelect ion_Sort .o -c testSelect ion_Sort .c
mv ClUnithutomated-Listing.xml ./¥XML/Listing.xml goo -LOCWCURit¥lib —o SortTest .exe testSelection_Sort .o Selection_Sort.o —louni-
mv CUnitAutomated-Results.xml ./XML/Results.xml SortTest . exe

vy CUnitautomated-List ing, xml  A¥MLAList ing, xml
my CUnitaotonat ed-Results, xml | SOMLPesults, xml

a4 == SortTest
[T i D :#hudsonSrol j obs®3ort Test¥work spacerexit O
> % Binaries Finished: SUCCESS
b [ Includes
4 = XML ~
3 cuntss — T
s CUnit-List xsl
& cunit-Run.dtd BxeL ] Cunit-List.dtd 1716 4= view
4= CUnit-Run.xsl [E] .coroiect [E] Cunit-List.xsl 4366
=| Listingxml SM S%undt? 1475
= Selection Sort.c CUnit-Run.xs| 4411
El Retr.ults.:-:ml ] Selection Sort.h [E] Listing.xml 3706
b [ Selection_Sort.c (] selection Sert.o E] Results.xml 3457
b [k Selection_Sorth Disﬂfﬂ'e_s"-exe B (all files in zip)
(g testSelection_Sort.c (] makefile

D testSelection Sort.c

Selection_Sort.o - [x86/1e] [E] testSelection Sort.o

(D SortTestexe - [x86/1e]
[ testSelection Sort.o - [x86/1g]

\_ [ & makefile Yy, \_ Yy,
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* Test Run Result

/[ cunit - Automated Test .. =\
&« C M | @ kesteriptime.org:8080/job/SortTest/ws/XML/Resultsxm w X[
O Hod @ HOolE *fiGoogle «F TZTV [P 117F W 27|®3F VW Wikipedia 3 GIO|HSE 3 Twitter » ] 7|8 =013
&A) ol Hox|= = 50] A& LITh HASAHE LR sd. x
CUnit - A Unit testing framework for C.
http://cunit. sourceforge.net/
Automated Test Run Results
EBunning Suite ASSERT _Test
Running test ASSERT TEST ... Passed
Running test ASSERT TRUE TEST ... Passed
Running test ASSERT EQUAL TEST ... Passed
EBunning test ASSERT STRING TEST ... Fassed
Running test ASSERT Fail Test ... Faled
File Name testSelection Sort.c Line Number 46
Condition CU_FAIL("fail test_fail")
Running Suite Type_Test
Running test TYPE INT TEST ... Passed
Bunning test TYPE CAPITAL TEST ... Passed
Eunning test TYPE SPECIAL TEST ... Fassed
Running test TYPE MIX TEST ... Passed
Cumulative Summary for Run
Type Total Run Succeeded Failed Inactive
Suites 2 2 = [ = 0 0
Teszt Cazes 9 9 g 1 0
Assertions 24 24 23 1 n/a
File Generated By CUnit ¥2.1-2 - Fri Jun 03 04:43:55 2011
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s List of Test

= | B [
/ [ cunit - suite and Test C... =\
€« C i | @ kesteriptime.org:8080/job/SortTest/ws/XML/Listing.xm w X[
4o @ HoE M icoogle € HEATV M 1187 W Y7|3 W Wikipedia 3 HO|HSE 3 Twitter » ] 7E =013

&N ol Holxi= 2 50} YaLth HABAIAS LR 28

CUnit - A Unit testing framework for C
http://cunit. sourceforge.net/

Total Number of Suites 2
Total Number of Test Cases 9

Listing of Registered Suites & Tests

Suite ASSERT _Test Mo Mo 5 Yes
Test  ASSERT TEST Yes
Test  ASSERT TRUE TEST Yes
Test  ASSERT EQUAL TEST Yes
Test  ASSERT STRING TEST Yes
Test ASSERT Fail Test Yes

Suite Type_Test [e] Mo 4 Yes
Test  TYPE INT TEST Yes
Test  TYPE CAPITAL TEST Yes
Test  TYPE SPECIAL TEST Yes
Test  TYPE MIX TEST Yes

File Generated By CUnit ¥2.1-2 - Fri Jun 03 04:43:55 2011
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